
Introduction to Premiere Pro 

by Daniel Nienhuis 
 

Workflow – setting up your files 

Before importing media or opening Premiere, create a folder for everything to go into.  It’s 

always better to be more organized than less, so don’t be afraid to make subfolders for video 

clips, stills, music, sound effects, text documents, reference materials, etc.  The important 

thing is that all these files live in the same place so that you can find them easily later.  You 

can think of this as the “master folder” for your project. 

 

Import your media into your master folder, either directly from the card/camera or by 

copying and pasting the files from somewhere else.  Some editing programs will copy the 

media you use to a central location.  Premiere does not do this – it leaves everything where it 

finds it, then goes back to that same place to look for the files later.  This is why it’s 

important to have everything in the same place, especially when you’re moving from one 

computer to another.  If you plan on using music, or stills, or sound effects, or anything else 

in your project, put the files in your master folder. 

 

Some cameras use fairly convoluted files structures and it’s not always easy to find your 

footage just by browsing.  If this is the case, one option is to copy the entire contents of the 

SD card (or CF card, or P2 drive, or whatever) over into the master folder.  Premiere usually 

does a good job of finding the actual video files during the import process.  You can also 

import video files using another program (iPhoto actually does this quite well), then drag 

them over to the master folder. 

 

Open Premiere!  Before the program will let you do anything, it will ask for some information 

– specifically, what to call your project and where to put it.  First, browse to your master 

folder.  Then give the project a name.  I personally like descriptive file names, so I try to 

include the date, the name of the project, and a version number (i.e. “July 2015 Premiere 

Tutorial 01”).  All the default options under the General tab are fine.  Under the Scratch 

Disks tab, make sure everything is set to Same as Project.  This will keep all the files 

together. 

 



 

 

Getting to know the interface 

When you first open Premiere, there will probably be lots of blank windows.  Depending on 

how the software is configured, these panels might be in different locations or hidden 

completely.  This is fine!  The interface of Premiere is extremely customizable and very 

simple to reset.  If you go to Window>Workspace in the menu bar, you can choose from many 

different layout options.  The normal Editing layout is probably the best bet for now.  If you 

accidentally close the wrong panel and things start to look strange, you can always go to 

Window>Workspace>Reset Current Workspace and things will go back to their default 

positions.  If there’s a specific panel you’re looking for later and can’t find it (Effect 

Controls, for example), select it from the Window drop down menu and it should appear. 

 

The many panels of Premiere can look complicated at first, but there are really only a few 

main areas where you’ll do most of your work.  The Project Window is where you access all 

the files in your project.  This includes the media you import, such as video clips, as well as 

things you create within Premiere, such as sequences and titles.  The Source Monitor is 
where you review these items – for example, you can open a video clip in the Source Monitor 

and set in and out points or create subclips.  Generally, after reviewing an item in the Source 

Monitor, it goes into the Timeline.  The Timeline is where you actually create your project 

by trimming and rearranging video clips, adding transitions, working with audio, and more. 

Premiere calls a collection of media in the Timeline a sequence and the two terms are 



basically interchangeable.  You can make many different sequences in a single project, which 

is great for trying different options.  The footage in the Timeline shows up in the Program 

Monitor.  This is usually the largest window and it shows what your project looks like – it’s 

where the video plays.  Finally, there are the Effects and Effect Controls windows.  The 

Effects window lists effects and transitions for both video and audio.  Effects are applied to 

individual clips and media, not the entire sequence.  The Effect Controls window shows 

anything added to your clip from the Effects window, but also basic information such as a 

clip’s scale, position, and the volume of the audio. 

 

There is also a small bar of icons called Tools, which contains the various interface tools that 

Premiere uses.  We’ll discuss what some of the different tools do later, but most of the time 

you’ll be using the default selector arrow. 

 

The basic process of editing a project involves moving through these various windows: clips 

are imported into the Project Window, reviewed and usually roughly trimmed in the Source 

Monitor, brought into the Timeline to be reordered and edited more precisely, and the 

assembled shots are viewed in the Program Monitor.  The clips are modified in the Effect 

Controls window as needed.  Different editing programs (Final Cut, AVID, Vegas, etc.) use 

slightly different terminology, but that’s essentially how all modern editing systems work. 

 

 

 

   



 

Before we get started… 

There are a few keyboard shortcuts that are helpful to know, even before any footage is 

imported.   

 

⌘S - Save.  I am pressing this constantly.  Premiere does a decent job of auto-saving, but 

losing any work can be a huge pain.  Get in the habit of hitting ⌘S all the time. 

 

⌘C - Copy.  You probably know this one already, but you’ll be using it a lot.  You can copy 

clips, sequences, effects, and more. 

 

⌘V - Paste.  Same story as ⌘C. 

 

⌘X - Cut.  Works like you’d expect, like copy and paste. 

 

⌘Z - Undo.  The undo command is your friend and you will use it a lot. 

 

⌘[shift]Z - Redo.  Undid a few too many times?  Adding the shift key will redo. 

 

V - Selection tool.  If your mouse pointer has turned into something you weren’t expecting – 

like a hand or a magnifying glass – press V and it will switch back to the normal arrow tool. 

 

There are lots and lots more 

keyboard shortcuts, but these 

should be enough to get going. 

There’s one more thing we 

should do before we get 

started, which is to go to 

Premiere 

Pro>Preferences>Auto Save… 

in the menu bar.  At its default 

setting, Premiere will save 

your work in the background 

every 15 minutes.  A lot can 

happen in 15 minutes, so 

changing this to a shorter 

interval – somewhere between 

1 and 5 minutes – is a good 

idea. 

 

 

 



If you’re working on a Mac, one other thing you should do is to go to the computer’s System 

Preferences and double-check how the mouse is configured.  Make sure that the “secondary 

click” is active, so that you can right click on items within Premiere - it’s often disabled by 

default.  I also like to uncheck Scroll direction: natural, but that’s really a matter of 

preference. 

 

Let’s go! 

There are several different ways of importing media into Premiere Pro.  You can drag files 

from the computer’s Finder directly into the Project Window.  You can double-click within 

the Program Window to open up a file browser.  You can press ⌘I to open the Import 

window.  There’s also a panel called the Media Browser – if you navigate to a file using it and 

double click, that file will be imported.  All of these methods do exactly the same thing: they 

make the file show up in the Project Window.  If Premiere can’t use a file, it will show an 

error message and the file won’t be imported.  That being said, Premiere should be able to 

work with just about any audio, video, or still format you want. 

 

Once you have media imported into the Project Window, you can either do some organizing 

or start editing.  If your project is complicated and involves lots of media – especially media 

with useless names like “Clip #4” or 092678.mov – doing some housekeeping when you first 

get started can save a lot of time in the long run.  Use the icons in the corner of the panel to 

switch between List View and Icon View – moving the mouse over a clip in Icon View will give 

you a mini-preview of the clip.  If you do a slow double-click on the name of a file, you can 

rename it within Premiere (the original file won’t be renamed).  You can also do this by 

right-clicking (or control-clicking) on a file and selecting Rename.  You can organize the 

media by selecting an option from the sorting icon.  You can also create bins, which are 

basically just folders, to sort things into categories.  For example, you could put all your still 

images in one bin and all your video in another.  Or you could put all your video from one 

shoot location in one bin and all your video from another location in a second bin.  All of 

these sorting methods are completely optional and you should find a method that works well 

for you.  Just keep in mind that staying organized will absolutely make your life easier. 

 

If you really want to stay organized, you may even want to color-code your media.  Premiere 

does some simple color-coding on its own -- titles are a different color than video clips, etc. 

-- but you can assign a custom color label at any time.  In projects with multiple interviews, 

for example, I tend to give each subject a different color, so that I can easily see the rhythm 

of the project at a glance.   

 

The color of a piece of media is noted by the small square to the left of its name in the 

Project Window.  To change the color, right click on the item and choose the Label menu. 

You can also change a clip’s label from the Timeline using the same method, although that 

will only change the label for that particular instance -- the media in the Project Window will 

retain its original label.  One odd quirk of Premiere is that it uses fairly “poetic” names for its 



color labels: “forest,” “mango,” “caribbean,” etc.  If you like, you can edit either the colors 

or their names by going to the Premiere Pro CC dropdown in the top menu and choosing 

Preferences>Label Colors…. 
 

 

 

Reviewing the footage 

If you double click on any piece of media in the Project Window, it will open in the Source 

Monitor.  In the Source Monitor, you can scrub through the footage using the pointer, or play 

it at normal speed with the space bar.  You can use the left and right arrow keys to go frame 

by frame or the home and end keys to jump to the beginning or end.  You can also use J,K, 
and L to go backwards, pause, and go forwards, respectively.  Pressing the L key will play at 

normal speed.  If you press L again while the footage is playing, it will speed up – you can do 

this several times to go through the footage very quickly.  Pressing K will stop and “reset” the 

play speed.  Pressing J works exactly the same way, except the footage plays in reverse. 

Once you get used to it, J, K, and L are probably the easiest way to review your clips. 

 

If you press the I key in the Source Monitor, it will set an In Point; if you press the O key, it 

will set an Out Point.  The in and out points tell Premiere what part of the footage to use. 

You can use in and out points to take only part of a clip into the Timeline, or you can use 

them to create subclips.  Subclips are useful if you have a long piece of footage that you only 

want to use parts of.  Find the section you want and set in and out points around it. 

Right-click/control-click on the video and select Create Subclip.  This will let you put only 

this section of the clip into the Project Window.  You can rename it to whatever would be 

useful.  The Restrict Trims option is checked by default, which is usually fine – it means that 

the subclip is restricted to only the footage you selected.  If you want to use a different part 

of the footage – outside the in and out points – you’ll need to choose it from the original clip, 

not the subclip.  Subclips are not strictly necessary, but they can be a very useful way to 

figure out which parts of your footage you want to use. 

 



Making a sequence in the Timeline 

The Timeline is where your project will actually take shape.  When you first open a new 

project, the Timeline will have nothing in it and the words “Drop media here to create 

sequence” will show on screen.  You can do just that; if you drag a clip or a subclip from the 

Project Window to the blank space, Premiere will create a new sequence in the Timeline 

window.  Creating a sequence this way automatically adjusts the resolution, frame rate, and 

other parameters of your project to those of that first piece of footage.  So, if you drag a clip 

that is 720x1280 resolution and 24 frames per second into the Timeline, that is what the 

Sequence will be set to.  If you then drag a clip that is 1080x1920 into the same Sequence, 
that clip will appear oversized and you’ll probably want to scale it down.  Premiere will let 

you put clips of completely different resolutions, frame rates, and file types into the same 

sequence, but it will set that Sequence to the settings of the first clip.  If you delete that 

clip, the settings will stay the same.  When you create a Sequence from a clip, make sure 

that the size and frame rate are what you want the final video to be. 

 

You can also create a new Sequence by right-clicking on a clip or subclip in the Project 

Window and selecting New Sequence From Clip.  Again, this will copy the settings from that 

clip.  If you want to create a Sequence from scratch, without referencing an existing clip, 

click on the icon in the Project Window next to the trash can – the blank square with a folded 

corner.  This is the New Item icon and it can be used to create new sequences, text titles, 

color bars, and more.  Selecting Sequence… will bring up a ton of preset sequence types to 

choose from.  However, the sheer number of options in this window can be confusing if you 

don’t know precisely what you’re looking for - I almost always just create a sequence from a 

clip or subclip. 

 

One thing to remember is that when you create a sequence from a clip, the name of that 

sequence will default to the same name as the clip.  Since clips and sequences both show up 

in the Project Window, this can get a bit confusing.  It’s a good idea to rename your 

sequence as soon as you make it, either by slow double-clicking the name in the Project 

Window, or by right-clicking on the sequence and choosing Rename.  You can tell a clip from 

a sequence by looking at their icons in the Project Window; sequences have icons with little 

bars stacked on top of each other, while clips have icons that look like little film strips.  If the 

clip has sound, the icon will also have a tiny waveform graphic. 

 

Moving clips and making edits 

Once you have a sequence in the Timeline, you’ll notice that it is made up of horizontal 

layers – these layers are called tracks.  Video tracks are on top and they are labeled V1, V2, 
V3, etc..   Audio tracks are on the bottom and they are labeled A1, A2, A3, etc.  The tracks 

in Premiere provide structure to your project as you build it.  If you’ve done any editing in 

Final Cut Pro X, you’ll notice some differences in the way the tracks in the Timeline behave. 

The timeline in Final Cut is “fluid” – it continually moves and changes shape as you add new 



media.  The tracks in Premiere are a much more rigid framework.  You can place a clip on any 

track at any point within the sequence and it will stay there until you move it.  Final Cut is an 

editing system designed to be fast – Premiere is an editing system designed to be precise. 

 

If you ever need a better view of your footage in a sequence, you can move your mouse over 

the name of a track (like V1) and scroll up – this will make the track larger.  Scrolling down 

will shrink it.  As video tracks get larger, you will see thumbnails of the clips.  As audio tracks 

get larger, you will see a waveform display of the audio.  You can also use your mouse pointer 

to grab and drag the border between the tracks in the same part of the Timeline.  Finally, 

the horizontal and vertical size of the sequence can be adjusted using the scroll bars on the 

side and bottom of the Timeline.  
 

Using the standard selection tool arrow (V), you can drag clips from the Project Window or 

Source Monitor onto and around the sequence in the Timeline.  Remember that only the part 

of a clip defined by in and out points will appear in the sequence.  If you have not set in and 

out points, the clip will drag over in its entirety (subclips will always drag over in their 

entirety, since they are already defined with in and out points).  Video on top tracks will play 

over video on lower tracks; if you put two videos of the same size on top of each other, you 

will only see the top one in the Program Monitor. 
 

In the Timeline, you should see a blue marker and vertical line.  It should appear under the 

timecode numbers at the top of the Timeline.  This is the playhead – the Program Window 

shows the point in the video that the playhead is pointed at.  If you have the Timeline 

highlighted (click on it) and press the Spacebar, the playhead will move in real time and your 

project will be viewable in the Program Monitor.  You can also use the J, K, and L keys to 

fast forward and rewind, just like in the Source Monitor.  You can grab the playhead and drag 

it with the mouse to look through the sequence manually.  If you click on some point in the 

timecode numbers, the playhead will jump to that point.  Pressing the left and right arrow 

keys will move the playhead forward and backward frame by frame; the up and down arrow 

keys will move to the start or end of the next clip. 

 

You can do basic editing by simply grabbing clips in the sequence and moving them around.  If 

you move your mouse over the beginning or end of a clip, you’ll see the selection tool arrow 

turn into a red arrow with a bracket on one end.  When the pointer looks like this, you can 

click and drag to adjust the length of the clip.  One easy way to edit clips in a sequence is to 

move the playhead to where you want the clip to start or end and then drag the end of the 

clip to that point.  The end of the clip will probably “stick” to the position of the playhead as 

you get close to it; this is a feature called Snapping and it’s incredibly useful.  You can turn 

Snap on or off by clicking the magnet icon in the Timeline or by simply pressing the S key. 

 

You can also cut clips into smaller chunks using the razor blade tool – either select it from the 

Tools panel or press C (“C for cut” is any easy way to remember this).  If you click on a clip 

using the razor blade tool, the clip will divide where you click. 



 

 

 

Insert and Overwrite 

If you grab a clip in a sequence and move it over another clip in the same track, then let go, 

you’ll see that the part of the old clip you covered with the new clip has disappeared – the 

new clip has replaced it.  If you grab the new clip and move it away again, the old clip will 

not reappear; it has been erased from the sequence. 

 

Replacing one clip with another in this way is called an “overwrite” edit, because it 

overwrites the old footage with the new clip.  If you want to move a clip without deleting the 

clip it replaces, you have a few options.  You can drag the clip to a different, higher track in 

the timeline; this will keep the old clip underneath the new one.  This is an ideal way to edit 

if you’re doing something like adding b-roll shots to an interview – you can place the b-roll on 

top of the interview and move the shots around as you please without affecting the footage 

on the track below.   

 

However, it’s often necessary to put a clip in between two other clips on the same track, 

moving everything after the new clip down the timeline.  This is called an “insert” edit, 

because you insert the new footage into the sequence without erasing any existing footage.  If 

you click and drag a clip in the Timeline, then hold the ⌘ key, the mouse icon will change 

slightly.  If you let go of the clip, everything to the right of it will slide down and the clip will 

be inserted.  If you insert a clip between two other clips, the clip to the right will slide down 

in its entirety.  If you insert a clip in the middle of another clip, that clip will be split at the 

insert point and the part to the right will slide down, along with everything that follows in the 



sequence.  If you want to put a clip between to other clips using this method, it will be 

helpful to have Snap turned on  (S key). 

 

Overwrite and insert edits can also be done from the Project Window or the Source Monitor. 
If you right/control-click on a clip or subclip in either panel, you can choose Insert or 

Overwrite from the dropdown menu that appears.  You can also use keyboard shortcuts to 

perform these edits: use the , key (comma) to insert and the . key (period) to overwrite. 

When you make an edit from the Project Window or Source Monitor, the edit will take place 

at wherever the playhead is located within the sequence currently open in the Timeline.   

 

 

 

There are other kinds of edits you can make – you can ripple, roll, slide, and slip footage in a 

sequence – but everything is based on overwriting or inserting.  As you get comfortable with 

the Premiere interface, feel free to play with the different options in the Tools panel.  Just 

remember that you can switch back to the standard selector with V and undo any damage you 

cause with ⌘Z. 
 

One potentially helpful tool is Track Select Forward – it’s the icon directly below the default 

arrow and can be switched to using the A key.  Track Select Forward will select everything 

on every track to the right of wherever you click in the sequence – when it is selected, your 

mouse pointer turns into two arrows pointed right.  If you hold shift with  Track Select 

Forward active, one of the arrows will disappear and you will only select clips in one track, 

instead of every track.  The A key is what you want to press if you need to select and move 

everything at once (or everything after a certain point) instead of grabbing and moving clips 



one by one.  As an alternative, multiple clips can be selected using the default selector arrow 

(V) by holding the shift key.  

 

Assigning audio tracks 

If you expand an audio track in the Premiere Timeline, you may notice that each track can 
actually contain two channels of video -- right and left, for a full stereo track.  However, 
sometimes footage is recorded with audio on only one channel and the second channel is blank. 
Or, sometimes different audio sources are recorded to different on the same stereo track.  When 
this is the case, you will probably need to reassign the channels, so that the same track plays 
on both the left and right channel. 
 
To do this, select a clip in the Timeline and right-click on it, choosing Audio Channels….  This 
will bring up a menu that shows both the Source Channel and the Channel in track.  By 
default, they should be the same -- the left source is in the left track channel and vice versa. 
Using the drop down menus, change the Source Channel so that they both show either left or 
right, depending on what the desired final channel is.  This is essentially creating a stereo track 
from two identical mono tracks. 

 
 
If you want to select only the audio track of a clip with both audio and video (to delete it or move 
it out of sync), you can either right-click on the clip and choose Unlink or alt-click on the audio 
track to select it alone. 
 

Adjusting audio and motion 

If you click on a clip in a sequence, that clip will appear in the Effect Controls window 

(remember that some windows may not be visible by default).  There are three sections under 

Video Effects – the most useful one is probably Motion.  Motion is used to adjust the scale, 

position, and rotation of a clip.  If you are using clips of multiple resolutions, it may be 

necessary to adjust these parameters. 



 

Under Audio Effects, there are sections for volume, 

channel volume, and panner.  For basic editing work, 

volume is probably the only one of these you’ll need 

to use – but it’s good to know where these controls 

are.  You may notice that there are small icons next 

to the various parameters that look like stop watches. 

This is for setting keyframes, which is a more 

advanced editing technique.  If the stopwatch is 

highlighted blue, keyframes are active.  We won’t 

cover keyframes here, so if you need to adjust a 

parameter where keyframes are active (like volume), 

click on the stopwatch to turn them off.  The icon will turn grey and you may get a warning 

message saying that “existing keyframes will be deleted.”  This is fine. 

 

You can make some very basic adjustments to audio and video in the tracks of a sequence in 

the Timeline as well.  On video tracks, you should see an eyeball icon.  Clicking this will turn 

off and on the visibility of all video on that track.  On audio tracks, there is are small buttons 

labeled M and an S – these stand for “mute” and “solo.”  Muting a track will turn off all audio 

on that track, while soloing it will silence all other tracks of audio.  Muting the audio track is 

probably the easiest way of removing all sound from a project.  There is also a lock icon next 

to every track, which prevents any changes from being made to it.   

 

 

Adding titles 

You can add text titles to your project by clicking the New Item icon in the Project Window 

and choosing Title.  Clicking this will bring up options for the title’s name and format, but it 

will default to whatever the settings are in the currently open sequence.  Clicking OK will 

bring up a new window with options for adding text and shapes.  The video in the title 

window will be whatever the playhead is on in the Timeline.  You can choose the text tool, 

click anywhere on the video, and type in a title.  This can be moved and scaled, and fonts can 



be chosen from the drop-down menu at the top.  You can adjust the fill, stroke, opacity, and 

drop shadow from the Title Properties on the right-hand side of the window.  There are also 

useful alignment tools on the left-hand side, if you want to be sure your text is centered 

horizontally or vertically. 

 

When your title looks the way you want it to, you can close the window.  It’s important to 

note that titles are not added to the sequence automatically – instead, they show up in the 

Project Window.  You can drag them into a sequence from there, then adjust their length by 

grabbing an end with the mouse and pulling them longer or shorter.  Be sure to put your title 

on a track above your video – if it’s below, you won’t be able to see it. 

 

 

Incidentally, if you ever find that you need more tracks than you have in a sequence, you can 

right-click on the left-hand side of the Timeline Window and select Add tracks.  You can also 

drag a clip to the area above the top track and Premiere will automatically create a new one. 

 

Effects, transitions, and clip speed 

There are a wide variety of video and audio effects built into Premiere’s Effects window.  You 

can find them either by clicking through the lists of categories, or by typing in the search bar 



at the top of the panel.  If you use the search function, be sure to delete your text using the 

X in the search box when you’re done – otherwise, you won’t be able to find anything else. 

 

Early on, you probably won’t be using many 

effects, but it can be fun to explore the various 

options.  For example, the Tint effect will 

desaturate footage, making it black and white – 

you can find it either by typing the word “tint” 

into the search bar, or by looking under Video 

Effects>Color Correction>Tint.  To add an 

effect to a clip, you can either drag it from the 

Effects window onto the clip in the Timeline, or 

double-click on the effect – it will be added to 

whatever clip is open in the Effect Controls. 
Effects in the Effect Controls window can be 

toggled on and off by clicking the FX icon next to 

the name of the effect.  You can also remove effects by clicking on their name and hitting the 

the Delete key on the keyboard. 

 

 

If you right-click on the beginning or ending of a clip in a sequence, you can choose Apply 

Default Transitions to add a dissolve to the clip.  You can adjust the length of the dissolve by 

right-clicking on it and choosing Set Transition Duration.  Adding a dissolve to a clip that is 

immediately next to another clip will cause the one clip to dissolve into the other (provided 

the clips are long enough).  Adding a dissolve to a clip that is not “touching” another clip will 

fade out that clip.  If there is video on a track below, that video will become visible.  If not, 

the clip will fade to black. 

 

There are also transitions in the Effects window, but most of the time you should probably 

use either a dissolve or a Dip To Black.  Elaborate wipes and other flashy transitions are 

almost always distracting. 

 

To change the speed of a clip, right-click on it in 

the Timeline and choose Speed/Duration from the 

drop down menu.  Adjusting the speed to over 100% 

will make the clip speed up; adjusting the speed to 

less than 100% will make it slow down.  You can also 

reverse the clip using Reverse Speed tick box. 

 

One important option in the Speed/Duration 

window is the Ripple Edit, Shift Trailing Clips tick 

box.  Checking this box will move all proceeding 

clips in the sequence relative to the new duration of 



the clip you adjust.  So, if you change the speed on a 5 second clip to 50%, that clip will 

become 10 seconds long.  If you check Ripple Edit, Shift Trailing Clips, no existing clips will 

be overwritten – instead, they will just move down the timeline. 

 

You can also change the speed of a clip before it is placed in a sequence by “re-interpreting” 

its frame rate.  For example, if you take footage that was recorded at 60 frames per second 

and interpret the footage at 30 frames per second, the clip will play at half speed.  To 

interpret footage, right click on the media in the Project Window and select 

Modify>Interpret Footage….  This will bring up a window with frame rate options.  By 

default, Use Frame Rate from File is selected; this is the frame rate that the footage was 

captured at.  If you click on Assume this frame rate, you can manually enter the desired 

frame rate.  Note that interpreting the footage from the Project Window changes the clip on 

a project-wide level, as opposed to using the Speed/Duration controls which adjust a single 

instance within a sequence.  Interpreting the footage will not change the frame rate of the 

original file (the one that lives in a folder on a hard drive), however. 

 

 

 

Basic color correction 

The color correction tools within Premiere have gotten more robust with each iteration.  While 
really advanced color correction work is still best handled by an external program, such as 
Adobe SpeedGrade or Davinci Resolve, it’s relatively simple to do basic color work within 
Premiere. 
 
I find it very helpful to use scopes when doing color correction.  Scopes give you an objective 
view of the light and color information in a shot and allow for more accurate adjustments than by 
just judging what looks good.  Different scopes - vectorscopes, histograms, parades, etc. - 
provide different information.  Here, we’re going to focus on the RGB parade. 
 



To access scopes in Premiere, go to Window>Reference Monitor.  This will open a window 
that can display information about the video in the Timeline.  By default, it may show the same 
content as the Program Monitor.  If you right click in the Reference Monitor and go to Display 
Mode, you’ll see the various view options.  Select RGB Parade.  
 
The RGB parade scope displays how much red, green, and blue is present in an image.  The 
top of the scope, marked 100, is white; the bottom of the scope, marked 0, is black.  So, an 
image with very blue highlights will have lots of blue at the top of the scope and an image with 
very red shadows will have lots of red at the bottom of the scope. 
 

 
 
In the image above, we can see that the vectorscope shows more red than green and more 
green than blue, especially at the top of the scope.  This means that the overall image is too 
warm, especially in the highlights.  Looking at the image itself, we can see that this is the case. 
 

There are several effects that can be applied to 
video to correct color imbalances like this - you can 
find them under the Color Correction section of the 
effects panel.  I personally find the easiest one to be 
the RGB Curves, since it corresponds so directly 
with the RGB Parade.  The RGB Curves effect 
allows you to adjust the red, green, blue, and master 
levels by clicking and dragging on individual curves. 
 
Small changes can make a big difference when 
making adjustments like this, so be conservative. 
It’s not an exact science - look at the scopes, look at 



the video itself, and play around to find the best results. 
 

 
 
In the image above, the reds have been lowered slightly and the blues have been raised. 
Notice that the orange tint from the original footage has been removed and that the red, green, 
and blue levels in the scope are much more even.  A slight “S” curve has also been applied to 
the master levels; this makes the highlights brighter and the shadows darker, resulting in an 
image with more contrast.  A reverse “S” curve will have the opposite effect.  
 
  



 
Once the color in the footage has been 
balanced, you can start to make stylistic 
choices.  Again, there are many effects to 
choose from, but I like to use the Fast 
Color Corrector for basic work.  It’s also 
located in the Color Correction section of 
the effects. 
 
The Fast Color Corrector has too many 
parameters to discuss in-depth here.  For 
now, pay attention to: the large color wheel, 
which adjusts the overall hue of the image; 
the saturation; and the Input Levels and 
Output Levels, which affect brightness and 
contrast.  The best way to get a handle on 
these effects is just to play around with 
them, so don’t be afraid to experiment with 
your footage. 
 
 

 
The image above has a slight shift towards an orange/yellow hue, increased saturation, and 
added contrast.  It has warmer skin tones and highlights than the version balanced with only the 
RGB Parade, but it doesn’t have the overall orange tint of the original footage. 
 



There’s one more tool I’d like to mention for changing the look of your project and that is 
adjustment layers.  Adjustment layers are like blank placeholders for effects - you place them on 
a track in the timeline and they affect all the tracks below them.  To create an adjustment layer, 
click on the New Item item in the Project Window and choose Adjustment Layer….  Make 
sure that the size and framerate match your sequence and click OK.  This will create a blank 
adjustment layer in the Project Window; you can drag it into a sequence just like a clip or title. 
Once it’s in the Timeline, the adjustment layer can be resized or cut using the razor tool.  
 
You may never need to use adjustment layers -- there aren’t that many instances where you 
would want to apply the exact same effect to multiple clips.  However, for things like making an 
entire sequence black and white or adding unusual effects to certain sections, it can be very 
convenient.  When I use adjustment layers, I place them all on the top video track, so that they 
can be easily switched off and on using the visibility icon in the Timeline. 
 
Rendering and playback 

Repeatedly rendering your sequence used to be the norm when editing -- watch a section, 
make a change, render, watch it again, make a change, re-render, etc.  Today, hardware and 
software are good enough to make this process mostly unnecessary.  Programs like Premiere 
and Final Cut render media in the background and most clips will just play seamlessly. 
However, as you add effects, transitions, and titles, you may notice that playback starts to slow 
down or skip. 

In the Timeline, you’ll probably notice a colored line below the timecode markers.  This line will 
either be green, yellow, or red and it’s Premiere’s way of telling you how well playback will work 
in different sections of a sequence.  As far as I can tell, it’s just a rough estimate - a red section 
may play fine or a yellow section may stutter - but it is very useful to see, at a glance, how well a 
section of the sequence will play. 

 



For the most part, only red sections should give you any trouble - green and yellow are usually 
fine.  To achieve smooth playback, you have a few options.  In the Program Monitor, below the 
video on the right side, you’ll find a little box with a dropdown arrow that probably says either 
“Full,” “½,” or “¼.”  That’s the resolution that video plays back at in that window: full, half, or 
quarter resolution.  Playing video back at a lower resolution is less intensive than full resolution, 
so changing this option can be helpful.  In fact, unless I’m using the Program Monitor full 
screen, I tend to keep the resolution at ½, since the difference is almost imperceptible.  At 
quarter resolution, things start to look blocky, but it’s still very usable.  There are also options for 
“⅛” and “1/16,” but these are greyed out, at least for me.  I’m not sure why these options are 
unavailable, but that resolution is probably too low to be helpful anyway.  Note that changing the 
resolution in the Program Monitor will not affect the quality of your final, exported video, so feel 
free to change it up depending on what works for your project. 
 
Your other option is to render part or all of the sequence you are working in.  This is essentially 
the same as the old “watch, edit, render, repeat” cycle, but sometimes it’s necessary.  Under the 
Sequence dropdown at the top of the screen, you’ll find some render commands.  Render 
Effects In to Out and Render In to Out are the most useful.  I think of Render Effects In to 
Out as a “quick” render - if your playback issues are minor, it’s probably all you need.  Selecting 
it (or hitting Enter in the Timeline) will quickly render and play from the beginning of your 
sequence, or from the in-point if you’ve created one.  Selecting Render In to Out is a slower, 
more intensive render.  It should bring everything to happy, smooth, green-label playback. 
Again, it will render and play from either the start of the sequence or the in-point. 
 
Advanced keyboard shortcuts for editing 

I was once told that you could tell an amateur editor from a professional by watching how much 
they used a mouse when editing - beginners scroll and click around, while advanced users 
rarely take their hands off the keyboard.  That’s a bit of an unfair generalization; you should edit 
in the way that feels most natural to you.  That being said, knowing some advanced shortcuts 
will make you a much faster editor.  Once you have a good handle on the basics, you should try 
to incorporate some of the following shortcuts into your workflow.  Most of these are primarily for 
use in the Timeline window. 
 
↑ and ↓ - In the Timeline, the up and down arrow keys move the playhead forward or backward 
to the next clip on a highlighted track.  A track is highlighted when the name of the track (V1, V2, 
etc.) on the left side of the sequence is blue.  Click on the name to highlight or unhighlight a 
specific track. 
 
⌘K - This makes a cut at the playhead.  If a clip is selected, only that clip will be cut; 

otherwise, everything under the playhead will be cut.  This is basically a faster way to use the 

razor tool. 
 



Q and W - These are my absolute favorite shortcuts.  Pressing Q will make a cut through any 
clips under the playhead, delete the parts of those clips to the left of the playhead, then ripple 
everything back to the previous cut point, deleting the gap.  Pressing W will do the same thing, 
but to the parts of the clips to the right of the playhead.  That probably sounds confusing, so you 
should just experiment for yourself to see the results.  Trust me, once you know how to use this 
shortcut, it will save you tons of time. 
 
Home and End - Home brings the playhead to the very beginning of the sequence, ignoring in 
and out points.  End brings the playhead to the end of the last piece of media in the sequence. 
 
= and - - The “equal” key and the “dash” key zoom the view of the Timeline in and out, 
respectively. 
 
\ - This is the key above Enter.  It resets the zoom level to fit the entire sequence on the screen. 
 
̀ - This is the key next to the number “1” on the top of the keyboard - it’s also the ~ key. 

Pressing this key will make whatever window you have selected (Timeline, Program Monitor, 
Effect Controls, etc.) fullscreen.  This is great for checking detail on the Program Monitor or 
making fine adjustments in other windows.  Pressing it again will return to the standard view. 
 
There are many more useful keyboard shortcuts and you’ll probably find yourself relying on 
them more and more as you become a more efficient editor.  For a more complete list and a 
downloadable “cheat sheet,” check out the following link: 
http://nofilmschool.com/2015/06/every-keyboard-shortcut-you-will-ever-need-premiere-pro-after-
effects 
 
Export your project 

After making all your edits and reviewing your project in the Program Monitor, you should 

finally be ready to export your finished project.  By default, Premiere will render everything 

in the open sequence, from the beginning of the timecode to the end of the last clip.  If you 

want to only render part of a sequence, you can use I and O to set in and out points, just like 

you did in the Source Monitor.   

 

You bring up the render options by choosing File>Export>Media… from the menu bar, or by 

simply pressing ⌘M.  There are a ton of render format options and if you know what you’re 

doing, you can really define all the parameters of your finished video file.  Premiere also 

gives you lots of useful presets, though. 

 

For video that will go on the web, the H.264 format does a great job.  If you plan on 

uploading your video to a streaming site, such as YouTube or Vimeo, you can select one of 

those options from the Preset drop-down menu.  The YouTube and Vimeo presets generally 

do a nice job of keeping the file size manageable and the quality of the video good. 

http://nofilmschool.com/2015/06/every-keyboard-shortcut-you-will-ever-need-premiere-pro-after-effects
http://nofilmschool.com/2015/06/every-keyboard-shortcut-you-will-ever-need-premiere-pro-after-effects


 

Before you export your project, you should click on the Output Name to input what the file 

will be called and where it will go.  It may be a good idea to create a subfolder within your 

master folder just for rendered video.  Most of the other options in this window can be left 

alone, at least for now. 

 

You have two options for rendering the video – if you click Queue, you will bring up the Media 

Encoder program and it will load your project.  This is fine, but it’s a bit more complicated 

than is strictly necessary.  If you simply click Export, the video will begin to render within 

Premiere. 

 

When your video is done rendering, navigate to it in the Finder of your computer and double 

click to watch it.  Even if you just watched your project all the way through in Premiere, it’s 

always a good idea to look over the finished video.  Mistakes during the render process aren’t 

common, but they do happen sometimes.  You may also notice new changes that you want to 

make once you watch your video rendered out.  If that’s the case, make your adjustments and 

simply re-render, giving your new version a new Output Name. 
 

That’s it for now!  Premiere is professional-grade software, but it’s also fairly intuitive, 

especially if you have experience with other Adobe programs.  As always, the best way to 

learn is to just dive in and start messing around.  Have fun and happy editing! 


